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A letter direct from the editor desk highlighting on September’17 edition 
We have recently published our September edition of SketchUp-Ur-Space 2017 which is full of new and exciting news for 
our readers who eagerly waits for every publication. SketchUp-Ur-Space is a well known magazine consists of 3D 
designing news for both the beginner and experienced designers and architects. The editorial team of SketchUp-Ur-Space 
has written some awesome stories, news, blogs and lots more to share the new things that can make the readers’ 
knowledge and skills updated. This magazine as like before presents its best to reach to the people with its writings with a 
promise to present unknown facts and news of 3D designing. 

The cover story of this magazine describes about the SketchUp Plugins for rendering in detail which is the best option for 
visualizing the 3D design in a picture perfect manner. 

The article section has come up with four new stories this time written by the editorial team of SketchUp-Ur-Space, where 
the shapes and components are shown with different tools and objects. The first one is about “Creating Component in 
SketchUp”, the second one is about the “Modeling Terrain and Other Rounded Shapes” in SketchUp. The third one is about 
shapes and the fourth one is about the camera tool. 

In the Blog section different news on SketchUp can be found which are needful for using SketchUp. There are four posts in 
this section, like the best ways to run the Sketchup smoothly, how the Sketchup’s plugins can be downloaded in free. Third 
one is the tips of keeping the SketchUp workflow simple and the last one is about the news of 3D Warehouse. 

Some ‘Trips and tricks’ are needed to manage the works of SketchUp smoothly and learning about new techniques. And 
SketchUp editorial team has just done that by enlisting four tips about resizing the SketchUp components. In the first one, 
there is news about using “Flip, Mirror and rotate”, resizing the components is also an easy thing and the second post is 
about that. The third and fourth one is about splitting and joining tools of SketchUp and The Skill Builder of SketchUp. 

The news is full of knowledge gathering information like about the Career options that the SketchUp users have, the 
Augmented reality, Trilogy Partners want a project Management Modeling where people can apply, transferring SketchUp 
into VR within just 10secs in some simple steps and more on. 

There are lots more in this new September Edition. Hope the readers could find their answers and they can explore a new 
world of 3D design. 

If you have any queries concerning publication, subscription, troubles navigating the site, 
please mail us at subhra@jobs2india.com 

 

Best wishes  
Subhra Bera 

Editor 
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Interview with Mauritz Snyman who is a specialist in 3D architectural 
modeling, 3D renderings, 3D visualization and 3D animations 

Interviewer: Simul Chowdhury (Editor) 

Introduce yourself to our readers. 

Hi all. Thank you for the opportunity Simul. I'm Mauritz Snyman & the owner of Jireh3D, a company I started in 2008 
focusing on 3D Architectural Modeling & Rendering. I'm based in South-Africa. 

I love what I do. Only a couple of things get me away from my computer - one being fishing. 

 

How did you start your career as a 3D modeler? 

I studied Interior Design but never pursued that. Not long after, I moved to the UK and started out as a CAD technician in 
London. But did not find it creative enough, so I started online 3D modeling training after hours. My boss at the time created 
a position for me but unfortunately during the 2008 recession more than half the company were made redundant. And so my 
own company, Jireh3D was born. 

What kind of hardware do you use? 

At the moment - Apple Mac 8 core, 2.1 Ghz, 64 GIG ram & 2 x 24'' Screens to make life easier. 

Then some other machines which are a lot smaller, but just a backup for rendering 

Can you tell us about the software you use in the studio? 

Sure. I use Sketch-up for all the basic modeling, then Cinema4D to add detail & rendering in VRay or Corona. Adobe 
Photoshop for the finishing touches. 
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Can you define the balance between Pure Render and Post Production in your work? 

Post production is great, but i like getting renders in such a state that there is little Photoshop work involved in the end. It 
depends on the artist really. 

I always use Photoshop to do final touches, but never to create the full image itself because clients change their minds very 
quickly & not many people wants to re-do everything again. 

 

Can you tell us something about your firm? 

My firm is running for about 9 years now. Jireh3D specializes in 3D architectural modelling, 3D renderings, 3D visualisation 
and 3D animations. We bring 2D plans to life in beautiful photo-realistic, 3D images. We create 3D models from CAD plans, 
sketches or simply ideas, supplied by the client. We are able to produce interior and exterior views of the proposed 
development. We can also create fly-through animations. 

Tell us about your work with 3D architectural modeling. 

For us, the modeling part is very important. If the modeling is bad, the renders will be bad. So adding detail is of great 
importance, as that is what helps create realism. 

After modeling, texturing is just as important. 
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Sketch-up is great for modeling things very fast, and if the client changes his design, it can be changed very quickly unlike 
most programs. 

Did you face any problems or technical issues along the project, and how did you solve them? 

50% of the time we run into problems during projects. Most of the time it's a machine that can crash because the scene is so 
poly heavy...Solving that was to upgrade memory & to use a render farm as our backup. 

Another problem is getting paid. What i have learned over the years, is to work with a contract & 50% upfront payment. I lost 
a lot of money because clients ran away, so very important to get a contract & proper payment terms in place. 

 

What was the most challenging project you’ve worked for, so far? 

The one I'm working on currently. Very big & difficult to work with because the model is so poly-heavy. It's for a few exterior 
renders, but the surroundings has tons of foliage which makes the process very slow and quite frustrating. 

What’s the hardest thing about being a professional 3D designer? 

Not getting paid enough for hard work and long hours. It's our bread and butter & lots of people take artists for granted. 

Where is architectural visualization heading next? 

Not sure, but because of the incredible technology, we are going forward really fast and it is difficult to keep up to date to the 
latest programs & plugins in the industry. 

What suggestions do you want to provide for newbie 3D modelers? 

If you want to do this full time, make sure you do it in excellence. Always give your best and be teachable so there will 
always be room for improvement. 

How do you evaluate our magazine? 

Very good. Lots of 3D Artists can learn from this & tons of info are available for anyone with many tips & tricks. 
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www.behance.net/Jireh3D 
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SketchUp Plugins for Rendering 

Simul Chowdhury: Editor 

SketchUp rendering is the option that allows you to visualize your 3D design in a picture perfect manner. The option 
enhances the quality of your work and markets your products the way you want. There are many SketchUp plugins for 
rendering available to give your design a perfect touch. Choosing the best option depends on the type of work you want to 
get from your 3D model. The content mentions names of plugins as many as it could. You can use one of them as per your 
requirement and demands. 

• AmbientOcclusion Lite: This plugin is helpful to get a fast visualization from your 3D model. It also gives a model a real 
touch with highlighting space. If you want more than usual features of rendering, you must opt for the AmbientOcclusion Pro 
that comes up with the depth of fields, colors and texture effects. 
Visit stg-extensions.sketchup.com 

• ArielVision: This rendering option follows the easiest steps to render your SketchUp model. Its easy-to-use interface 
makes the rendering process simpler with focusing on some essential features of rendering. You can start rendering just by 
one click. 
To download the application, visit extensions.sketchup.com 

• Bloom Unit: Bloom Unit uses the cloud computing system to create a photo-realistic view of your images. You no need to 
be expert in every detail of rendering since it anonymously adds all essential features your model needs. 
Do not forget to visit www.bloomunit.com 

• Brighter3D: This extension promises to give you a hassle-free ways of rendering on SketchUp. The built-in features 
automatically look after important things like lighting, noise and material. It also offers you the multi-threading option with 
which your system will create a realistic image of your design using the CPU power without the need for graphic cards. 
Visit www.brighter3d.com 

• Corona Renderer: Corona Render solves every problem regarding rendering and transforms your model into a real visual. 
The extension gets updated offering you new features and functions. 
Follow corona-renderer.com to get more information. 

• FluidRay: Rendering with FluidRay is faster and better as it prepares a visually stunning picture for your 3D models, 
architecture and interior design. 
Visit www.fluidray.com for more details. 

• LightUp: LightUp is an object-based rendering that instantly transforms your model to a visually appealing object on the 
SketchUp window itself. The extension ensures that you will get no-waiting rendering opposed to the traditional process. 
Visit www.light-up.co.uk to know more or download the plug-in. 

• LumenRT: It is another rendering extension for SketchUp that helps you create a photo-realistic view of your design. It 
understands the photographic environment better than others. 
To know more about the design, visit www.lumenrt.com 

 

mailto:simul@jobs2india.com�
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How to Create Component in SketchUp 

Simul Chowdhury: Editor 

When an object of your design has several uses in a model, component tool proves to be a great help for you. It saves your 
time from repeating the same design you need. Creating components enhances the accuracy of a model, and it is a must-
to-apply trick for expert modelers. Benefits of using this feature can be felt while designing a model. Below are a few things 
that you can do with the component tool. 

• You can reuse your component whenever you want. 
• The geometry of a component stays separate from other components connected with it. 
• You can also edit component whenever you feel so. 
• You can cut a hole in a face with your component and can also stick it to a specific plan by changing setting of the glue 
panel. 

Creating components can be made in the model itself or a separate SketchUp file. The create component dialog box will 
help you put the needed specification in your component object. 

The steps that you need to follow for creating a component are given below. 

1. Select the geometry of the object you want to make a component. 
2. Go for the Edit > Make Component. A Create Component Dialog Box will appear. 
3. In the Definition tab, give a proper name to your component. 
4. Ad a short description of your component to the Description. 
5. To use gluing plane, you need to select an option from its Glue To drop down list that contains – Horizontal, Vertical and 
Sloped. If you are using Glue To option, a few changes you will notice such as Cut Opening Check Box will be active and 
Always Face camera and Shadow Face Sun will be inactive. 

6. (For Cut Opening Option Only) if you want to use the Cut Opening option for your component, select the check box. 
7. (For Always Face Camera Only) Always Face Camera helps you turn your 3D model into 2D forms without hitting the 
rendering option. If you apply this feature to your component, the Shadow Face Sun will also be active. 
8. (For Face Sun Only) the feature is used in casting shadows of your components. The shadows will be cast the same way 
as the component is facing the sun. 
9. (For Set Component Axes only) Set Component Axes defines the component’s axis origin. When you press the button, 
the cursor will tell you to insert a new axis for your component. Once you are done, the Create Component Dialog Box will 
be re-active again. 
10. (For Selecting Type) the Type drop-down menu will help you classify your components. 
11. For transforming the geometry you have selected for creating component, let the Replace Selection with Check Box 
selected. 
12. Click the ‘Create’ button for creating the component. 

These are the steps that you get while making components from the geometry of the model. Following this method will bring 
you a component that you can use several times in your design. You can also get video tutorials on the internet that 
provides a complete guide on how to create a component in SketchUp. 

Video tutorial for the component: 

https://youtu.be/fSw4pAMXf0U 
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Modeling Terrain and Other Rounded Shapes 

Simul Chowdhury: Editor 

Drawing terrain in SketchUp does not require you to be a pro in the 3D designing. You can sketch the model as simply as 
you draw a line on a paper. But your 3D model needs other things to mirror the objects or scenes as accurately as the real 
one. The model you are drawing gets a special look when you add grounds and landscape. Along with terrains other forms 
of designing create a visually satisfied project. But how SketchUp perform all these tasks so efficiently is the question of 
many modelers. The content brings out the hidden facts of SketchUp tool in designing terrain and other round faces. 

The answer actually lies in SketchUp Geometry. All SketchUp users must be familiar with the term – Sandbox tool – the tool 
needed for designing terrain. With this tool, you are originally using a special type of geometry – TIN that allows you to draw 
anything as per your wish. 

TIN stands for Triangulated Irregular Network which is commonly popular as ‘a group comprised of triangles.’ The below 
image shows hills carved by TIN. 

The content below deals with technicalities of designing TINs and Sandbox tools. The basics of designing that you must 
learn to Sketch the complex model in 3D. 

Get started with TIN: If you are creating TIN first time, then you must try simple designs rather than opt for the complex 
ones. You need to import contour lines from another application or can import terrain from Google Earth using SketchUp 
building tools. Your drawing onto the TIN can is used in your design. But the easiest option will definitely be drawing a flat 
rectangular TIN. 

For importing pre-existing terrain, Visit help.sketchup.com and for designing terrain from scratch, click help.sketchup.com 

Use Sandbox tool: Sandbox tools stay in a sandbox toolbar or you can follow the steps – Tools > Sandbox 

If you are designing a terrain, you can geolocate the model or add a geographic location embedment that places your model 
into a specific point of the model. Advantages of using geolocated the model are given below: 

• You can get a comprehensive idea of sunlight and sun shadows that add a different angle to your model. Light effects 
always take a picture to a new level and your design will get a sense of reality with this. 
• You can view your design in Google Earth. 

Geolocated terrain helps your model locate into a specific place on the earth. You can also add different functions and 
features with the sandbox. 

Reference: help.sketchup.com 
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Place Shapes Toolbar is the newest Sketchup extension 

Subhra Bera: Editor 

SketchUp is expert in creating variant tools for handling the shapes and designs smoothly for the designers and architects. 
This time they have launched Place Shapes Toolbar. It can be applied in the different versions of SketchUP. In this article 
the work of this toolbar is described. The readers can assume this toolbar by reading various descriptions of the tool. It is 
easy and good for creating designs for both big and small fields. Its use and tips are also given here. Let’s have a check on 
it. There is also a link is given for videos and tutorials. 

Place Shapes Toolbar is a new Sketchup plugin invented by Alex Schreyer. This brand new Sketchup plugin supports 
different versions of Sketchup like SketchUp 8, SketchUp 2013, SketchUp 2014, SketchUp 2015, SketchUp 2016 and 
SketchUp 2017. 

This extension has a toolbar with some menu items that is used for setting simply different common 3D shapes or geometric 
primitives. SketchUp’s navigate tools allow users for creating any shapes without too much effort. With the use of this 
toolbar, the users can accomplish fast “solid-based” modeling for dealing with added and subtracted primitives who can 
produce a precisely watertight object that is ideal for 3D printing. Prior for changing the shapes, anyone can opt for a 
general unit like foot, inch, mm, cm, m etc. 

This toolbar is a good starter shape set for the new users and the kids who want to play in 3D modeling but don’t have any 
interest to learn. 

Usage

For more information and video please follow: 

: At first show to the “Place Shapes” toolbar and click on the shape that has to be placed. Or the other way is to apply 
the Draw menu’s items. Most of the shapes will adjust themselves in the basis of the underlying geometry. Arranging 
various shapes is also possible by going to the select tool or pressing the space bar or the ESC key after finishing. 

After placing a shape, move and scale tools can be applied for moving and functioning on the shape. In the case of failing 
work of any shape as per the requirement right click on it and choose ‘unglue’. In the case of placing any shapes, they all 
stick to the elementary geometry. Exploding a shape to work with its raw geometry is also possible only by applying the 
right-click menu. While selecting the base unit from the dialog, all the following placements will get that unit. The items that 
are already arranged don’t need scaling. This is helpful for modeling small stuff like 3D printing or large stuff like buildings. 

Tips for working on this tool: 

a. At first turn on the X-Ray face style to enable snapping for the hidden points. 
b. Go to View>Hidden Lines to allow the hidden lines visible for more precise snapping. 
c. These shapes fit well with the SketchUp Pro’s Solid Tools 
d. For adding Text to any of the shapes use the 3D TextTool. 

extensions.sketchup.com 
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SketchUp Camera Tool – Change the View of your Design 

Simul Chowdhury: Editor 

In SketchUp, you have to have a complete idea about the View tool since it gives your design an ultimate angle. A good 
designer earns an in-depth knowledge of how to use every feature of view to make their design the best. Camera tool 
generally works in two ways – one that jumps views from one point to another such as back, left, right, and from; another 
moves camera position from one point to another such as zoom and pan. 

The view tool stays in the Camera option from where you can navigate the position of your model visually. Take a note of 
the content below that provides you with a comprehensive idea of what View tool offers. 

• Iso: it is for giving your design a slightly angled front view. It has a specific application in your design with adding 
perspective and relationship of the project. 
• Top: as the name says, it is for the top view of your model. Sometimes, Top view creates a flat look of your model. Use 
Zoom in and out to recognize the actual distance of your model. 

• Front: the front view proves to be the best option when you start designing on SketchUp first. 
• Right: the Right tool allows you to jump from back to front, right and left views. 
• Back: Back gets less attention as compared to the other sides of your design. But the back view is as essential as the 
other view of the model. 
• Orbit tool: with this tool, you can see the view from any direction of your model. Navigating the application is also easier. 
To observe the different views of the model, you need to drag your model to the direction you want to see. 

• Pan Tool: Pan tool helps you move the model from one point to another. You will proceed along with the gradual move of 
the design. Using the tool is like grabbing and dragging a model. 
• Zoom: the tool used has been used in the same way as it was used. Zoom in for observing the smallest detailing and 
Zoom out for view the model in a biz size. 
• Zoon Extent: this feature generally zooms out your model to the maximum extent. 

Viewing your design from right direction is as much essential as a flawless design. The above-said tool will help you choose 
the right angle and sites you want to observe your design. To know how to use the camera angle more prominently, visit 

https://youtu.be/PenO4l_ulr8 
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Best 11 Ways to Make SketchUp Run Smoothly 
Simul Chowdhury: Editor 

Every 3D designing application more or less runs slow on your operating system as long as a complex designing is 
concerned. SketchUp, though the simplest application of all, crashes many a time while you are working on it. To improve 
the working of the 3D application, you must adopt ways that lead you to the smooth functioning of the application. There is a 
plug-in called SketchUp Bug Splat to enhance the performance, but performance issues still exist. The content tells you 
about 11 tips that make your SketchUp run smoothly. The steps will help you cut down the SketchUp problem at a wide 
extent. 

There are a few common tricks that are must perform to keep your designing on track regardless of crashes or anything. 
Some proactive measures should be taken that save your work from a sudden damage due to a poor performance of 
SketchUp. Three things you must keep in mind while designing on SketchUp. 

1. You must hit a Save button often when you work on SketchUp to prevent you’re designing from a loss. 
2. In SketchUp, not everything will be damaged if the application crashes. SketchUp prepares a backup file of your work in 
.skb extension. You can transfer .skb to .skp whenever you design. 
3. You can select a setting that leads SketchUp to save backup files. To make the setting apt for saving your work, follow 
window > Tab > General. 

Besides these above-mentioned steps, 11 easiest options are there that will help you enhance the performance of your 
SketchUp. 

1. Update SketchUp version: you must update the version you are using if your SketchUp runs slow. Google has handed 
over SketchUp ownership to Trimble in 2012. So, if you are still using the old version, you must install the new one for better 
performance. 
2. Purged unnecessary things: SketchUp keeps every component as a backup even after you delete them. This 
unnecessarily enlarges the file size leading to the slow performance of the size. You must click the ‘purged unused’ option 
to delete those extra details which you don’t need. This will reduce the file size. 
3. Keep your design theme free: shadows and styles that you add personally can be the reason of the poor performance of 
the application. Try to use the default setting for adding shadows and effects to your style. 
4. Hidden geometry should be deleted – in a 3D designing model, hidden geometries are stored in the design to a large 
extent. These hidden items must be deleted to keep the file size within the required limit. To see the hidden things, follow 
View > Hidden Geometry. 
5. Scene names: do not add unusual character to the scene name of SketchUp. It lowers the performance of the application. 
6. Layer man: if your model needs heavy components like trees or cars, you must move the components to entourage layer. 
7. Abandon ship: when you file gets corrupt, copy all 3D data from the files and paste to a new file. 
8. Graphic driver: you must update the graphic driver of your system if you want to run SketchUp faster. 
9. Plugin: the newly installed or updated plugins are the source of SketchUp Bug splats. When you get a bug splat at the 
time of creating a new file, you must delete that plugin. 
10. File Size: if you get bug splat at the time of opening a file, check the size of the file. If it is massive, try to reduce the size 
using Purged Unused or deleting unnecessary components. 
11. The Upgrade: If your SketchUp performs poor even following the above 10 tricks, you must upgrade the complete 
system. This is the only solution left for you. 

The application that runs faster provides the result with as much accuracy as we want. Since SketchUp is one among the 
most downloaded applications, it must run smoothly to meet our demands. The tricks will definitely help you when you 
encounter any performance problem. 

If you need more tips and tutorials, visit www.designerhacks.com 
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Free SketchUp plugins for download 

Subhra Bera: Editor 

It is known that Sketchup is the easiest and the best tool for modeling and designing for the architects. Google has obtained 
this software in order to the crowd-source the 3D modeling of the earth. For this thing anyone can use this software in their 
house or school or favorite building. This software is fast and also very simple to use and appropriate for all, but that doesn’t 
mean it has less features.  
Everyone can use it and it is free to download. There are many options available on the free standard version of SketchUp 
or for more option another version SketchUp Pro is available. The both versions can be extended via plugins. All the two 
plugins are very useful and free. 

The first plugin is Soap Skin & Bubbles. This plugin is designed by a German engineer Josef Leibinger to help the users in 
the study of mechanically and freshly strained surfaces. The author has also developed a new plugin for tensile structures 
and it would release later. But without that development anyone can play with the tensile structures in this plugin. This type 
of plugin can be downloaded from their website for free and there are several video tutorials on The SketchUp Show. 

And the second plugin had developed by the Integrated Environmental Solutions that allows the users to elect important 
sustainable design information such as location, different buildings and rooms, various construction and HVAC systems in 
the SketchUp model. In this option various works can be done like energy, carbon, daylight and solar analysis or the model 
can be taken with all this information in the BIM software. This also allows to More info and helps to download the IES 
Sketchup plugin website. These two helpful tools are there as a help of the design process with the ease of use of 
Sketchup. 

For more videos please follow the link youtube.com 
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Simplify workflow with component mirroring 

Subhra Bera: Editor 

Eric Schimelpfening is the founder of SketchThis.Net and has applied 3D technology in his entire career. He has converted 
his pencil and paper operations into ideas through 3D, worked with Google on the development of SketchUp, created 3D 
content for both large and small companies and also given lessons to the numberless students all over the country. He is 
also a famous columnist in Kitchen and Bath Design News and often gets calls to teach SketchUp and speak on appearing 
technologies for the design field. 

As Eric has a great knowledge over SketchUp so one of the folks of SketchUp team requested him to make a desk in eth 
office space. He in earlier times made some Open desks and Maker Benches also and this time also decided to make 
something new. So he thought to involve some galvanized pipes in it, and it had taken only a few minutes to put them 
together. Though it was not a complete engineering planned model though it was a general design and he also made some 
emphasis on it. After some more emphasis it had become a beautiful picture and then he had made some engineering 
details also. 

Next after putting details he transferred it into a CNC mill model and it was full of all kinds of fiddly bits like bolts, hardware, 
dowels and detailed joinery as like other complex models. Eric’s specialty is that he always starts his designs simply and 
after that he adds more advanced modeling to make it an engineered model. According to him, the use of components 
maintains the symmetry and it is effective in various ways like at first some simple components can be put as a bunch of 
geometry which can be reused again and again and if one of the components can be edited, the whole thing will change. 

It is useful as when somebody has to put same thing in the component like stair treads, balusters, tiles or any other thing, 
the person is required only to make new copies of them. Eric showed that he use components for the model in a little 
different way as like for creating symmetry. In his video he has shown the process of making the symmetry by drawing 
tabletop at first. Then he used the move toll and ‘flip along’ to give it a shape and with the help of different tolls he end up it 
as a table and the components that he used were mirrored. By turning on the ‘hidden geometry’ option the mirror lines can 
be seen and he could change the shape easily by maintain the symmetry. 

In his symmetry model he had added every little thing properly like bolt hole, piece of hardware, round-overs and other 
details. In his modeled work, each and everything got mirrored and it saved time by reducing the chance of making 
mistakes. This is not for only symmetry but it can be useful for buildings, 3D prints, and woodworking, metal-working and 
other things also. 

For other details please visit: blog.sketchup.com 
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Things to Know about 3D Warehouse of SketchUp 

Simul Chowdhury: Editor  

SketchUp has brought to you everything in a comprehensive and understandable way. Designing on the application is 
easier than ever. Simple tools and features help you draw intense designs in no time. To make your design even easier, 
SketchUp offers you 3D Warehouse – the biggest library of 3D designs. You can download 3D models from the warehouse 
that makes your design complete without wasting time in scratching small details. You can download, locate, search and 
distribute models from the library. 

3D warehouse proves useful when it comes to adding small 3d models to your design. The warehouse contains an array of 
models that are uploaded by designers across the world. You can easily access to these models that suit your design. It not 
only cuts down the time required for completing your design but also maintains the accuracy of your design like an expert’s 
work. 

You have to accept the terms and conditions first before doing anything in the 3D warehouse. You need to open an account 
that allows you to access to the designs and models from the library. Having a Google ID is enough to open an account that 
takes you to the library contained thousands of models and designs. 

Agreeing terms of 3D Warehouse means that you are allowing Google to share your account information with the 3D library. 
So, confidentiality is an important thing that you need to take care of. The 3D warehouse has the authority to terminate your 
access any time if you breach any rules. 

An age restriction is also there that says designers below 13 years are not eligible to access to the information. Parental 
consents are required to allow them to the 3D warehouse. 

3D Warehouse materials also contain designs and models offered by third parties. The authority does not endorse and 
guarantee these products. The authority will not be responsible for any liability in respect of the model published in the 3D 
Warehouse. 

Other restrictions are also there with regard to materials and products: 

• You may not use or modify materials of 3D Warehouse for public display, sale or any commercial purpose. 
• You are not allowed to modify or remove copyright and other essential documents. 
• You are not eligible for redistributing or transferring 3D models to another person. 

The Warehouse clearly presents that you cannot use 3D materials unlawfully. Misuse of the models posted in the library is 
strictly prohibited. You have to follow the rules if you want an unhindered access to models and information. 

Knowing 3D Warehouse completely in a short brief is not possible. It contains many minor to major issues that help you 
understand the model library better. 

Article Source: 3dwarehouse.sketchup.com 
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Flip, Mirror, and Rotate for SketchUp 

Simul Chowdhury: Editor 

Flipping and rotating tools make your 3D designing a fun experience as you can easily draw the complex things with these 
applications. A proper use of these features will allow you to navigate some difficult jobs in 3D modeling software like 
mirroring an object. The general application of flip tool is that you can backflip geometry to 180 degree angle. The rotate tool 
helps your model spin and fold to fit into your designing requirements. The content describes the details of using these 
applications in a way that you have never applied before. 

How to flip geometry along an axis

 

: 

• Select the geometry with the select tool. 
• Context-click your model and choose a flip along 
• Select an axis Below picture represents the flip application along blue axis (1) and red axis (2) 

How to mirror geometry

 

: 

In SketchUp, creating a mirror image is as simple as designing the basic 3D models. All you have to do is using two 
functions – copy and flip – together. If you want to create a mirror image, only one half of the model is required. Design one 
half of the model (1) copy it (2) flip it (3). Your main image mirrors the reflection as accurately as you want. 

mailto:simul@jobs2india.com�
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Rotating Geometry at an angle

 

These features have many things to denote in your 3D modeling and the above-mention information reveals a small part of 
it. 

: 

Rotate tool is used for rotating an object at different angles. Here a model of a telescope is rotated to observe different parts 
of the sky. 

• Select the geometry you want to rotate. Here telescope is selected, but its base remains unselected. 
• Select the rotate tool; the rotate-shaped cursor will appear. 
• Move the cursor to your desired plane. To lock the plane, press the Shift key until the angle vertex is set. When the plane 
stays at perpendicular point to an axis, the cursor changes the color in red, green or blue. 

For more details about the tools and features, you need to visit: help.sketchup.com 
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How to resize components in SketchUp 

Subhra Bera: Editor 

SketchUp is a wonderful modeler for architects and designers and the new version of SketchUp has also come with new 
features for us. SketchUp 8 is a 3D modeling program that known as Google SketchUp in earlier. This program is also 
available in a fully useful free version and also the Pro version is available that has more features. This software helps the 
users in their business that deals regularly with the perfect modeling objects like in the architectural or design fields. Besides 
creating the users own components, the software also have pre-built models that can be resized as per the needs. Those 
newly created components could be resized with the Tape Measure tool and the other pre-built components can be altered 
with the scale tool. 

Resizing pre-built components: 

1. At first the SketchUp should be launched and then click on “Choose Template” from the Splash screen. The selected 
template determines the measuring units for the objects and components. 
2. Then click “Start using SketchUp” button after selecting a template which can be the match of the required measuring 
units. 
3. Next click on “Window” option form the Menu Bar and click “Components” for viewing the Components window. 
4. Select the components for setting the starting point and then click on it for placing it on the main SketchUp screen. 
5. Now click on Tools < Dimensions. After that the cursor will be turned in a purple dot that can be moved over the 
document that wants to resize. 
6. After that click on the section of the components for setting the starting point of the dimension and click to place the 
endpoint. Sketchup will quickly display the dimensions for the selected distance. 
7. Next click Tools>Scale from the Menu bar and click the component wished to resize. 
8. At last click and drag one of the scaling grips for resizing the component. 

Resizing newly created components

For more information please visit 

: 

1. At first launch SketchUp and then click on “Choose Template” from the splash screen. The selected template determines 
the measuring units for the objects and components. 
2. Then click “Start using SketchUp” button after selecting the matching template with the required measuring units. 
3. Then click on “File”>Open from the menu bar for selecting the resized components. 
4. Now select the Tape measure tool from the toolbar and click anywhere for selecting the starting point of measurement. 
5. Then move the cursor and select the ending point of the measurement. 
6. Next type a new length for the measurement from the Measurement toolbar and press “Enter”. 
7. Then only click “Yes” at the prompted time and the component will automatically take the measurement. 

smallbusiness.chron.com 
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How to Use Split and Join Tools in SketchUp 

Simul Chowdhury: Editor 

Split and join tools in SketchUp offer you the known applications correctly described by their names themselves. In this 3D 
application, LayOut Split and Join tools offer the easiest way to design a complex shape by splitting and joining. A few steps 
are there that help you do the needed cut and join on your design. Generally, split tool is for tearing a design apart while the 
joining tool joins one or more shapes together. 

Steps to follow for splitting a line or a shape: 

• Select the Split tool by selecting tools > split. 
• Click on the areas of lines or edges you want to split. 

The splitting parts of the design can be dragged or dropped anywhere in the design. The picture below rightly presents how 
to use split tool for your design. 

The best thing is that you can use both Split and Join tools together to design a complex shape. If you want to use the tool 
in the best way, you have to go to the core and learn the basic part of this application. 

Follow the steps if you want to join two or more shapes together: 

• Use the Select tool to drag the shapes and drop them so that they overlap each other. As it is shown in the Figure 1 
(Callout 1). 
• Click the Split tool. 
• For Shared Vertex, you need to click on every overlap points. On hovering over the split cursor over these points, a red X 
and an Intersection ToolTIP will appear. 
• Use the erase tool to delete the unnecessary part of your design before giving your model a final touch. 
• Click the join tool to glue the split part to make a complete model. 
• Click on edge of each piece when the Join tool cursor is active. The color fills in the shape with every click. The fill color 
will be the color of the shape you click first. See Callout 4. 

The Split tool has many applications in our SketchUp design. Bending is another thing that is a popular feature for 
designers. Bending defines the curves of your design instead of the split points. For designing different complex structures, 
bending will prove a great tool. LayOut Path Editor is the tool that you need to bend the lines and shapes in SketchUp. 

Source: help.sketchup.com 
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SketchUp Skill Builder 

Subhra Bera: Editor 

Josh Reilly has become a part of Google SketchUp since 2008 as a SketchUp Trainer and later rejoined with SketchUp 
Trimble in 2013. He has a good knowledge in SketchUp designing and labeling and also creating new things. He is fond of 
maps so he thought to make a topic on mapping images to curve the surfaces in SketchUp with the use of Skill Builder. 

According to him, textures or materials have a very important part in SketchUp designs as they can perform the important 
role of combining the geometry with life. A well-technique wine label is the presentation of a well-textured SketchUp model 
which allows the user to explore the contents. For the advanced users of the application of textures on flat faces, he suggest 
to watch two short videos which demonstrates the process of painting and projecting textures on more complex and curved 
surfaces. 

In the first video, Reilly has demonstrated a step-by-step breakdown of the workflow. The process is described here: 

1. At first, the Select tool is used for using the geometry where a texture needs to apply. To enter Groups or Components 
double click is necessary. 
2. Then go to View > Hidden Geometry to affirm the polygon breakdown of the curved surface. 
3. Next go to File > Import…. Option and then browse the image file in the import dialog box. 
4. Before clicking on the “Import” option, verify that “Use As Texture” option is selected. 
5. To position the image in the selected area click once in the bottom edge of the face. 
6. Again click on the top edge of that face for painting the image there. 
7. For manipulating the image, right-click on the image and go to Texture > Position. 
8. The paint Bucket tool is used to sample that texture by the modify key and then apply that texture to the remainder of the 
curved surface. 
9. Then go back to View > Hidden Geometry for turning that mode off. 
10. This handiwork must be admired. 

The above process is used in the simple surface; the second video is about managing a little more complex workflow: 
projecting textures onto complex surfaces… The step-by-step breakdown of the workflow is described below: 

1. At first a simple rectangular face, where the image will be imported has to draw which should match the size of the curved 
surface. 
2. Then go to File > Import… and browse the image file in the Import dialog box. 
3. Before clicking on “Import” verify that “Use As Texture” is selected. 
4. At first click on the anchor point and then click again to finish the image placement. 
5. Then Right-click on the image and go to Texture > Position for manipulating the texture to make it fixed in the position on 
the curved surface. 
6. Now Right-click on the imported image and go to Texture > Projected that is important. 
7. Now use the option Paint Bucket Tool to sample that recent projected texture and apply it to the curved surface. 

There are many more options that can be done on textures in SketchUp by Skill Builder like: 

• Applying Colors, Photos, Materials and Textures 
• Sticking a picture or Texture to a face 
• Adding colors and Textures with Materials 

For more information and the videos visit blog.sketchup.com 
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Augmented reality on the desktop 

Subhra Bera: Editor 

Augmented Reality or AR is a live direct or indirect view of a real-world; physical environment whose elements are enlarged 
by a computer generated sensory input like sound, video, graphics etc. it is related to computer mediated reality. In it the 
reality view is modified by a computer. It is a new technology that has started to spread. Generally it is a mixed of 3D model 
with live footage in real time. 

This concept has already applied on the futuristic interfaces and it allows architects to take their 3D model a step ahead 
placing on the real world and showing it to the clients. So it is very helpful for the architects. These techniques are showed 
in the real time and over a live video feed of a sporting event. 

With the help of advanced AR technology, one can start playing with Augmented Reality. This plugin allows placing the 3D 
model on the live video form webcam, and can move it around. In this tutorial video the process is described. This also can 
calculate the planes on the live video and has a sheet for print out. This software can calculate the distance and inclination. 
The information can be virtual or real. This technology brings out the components of the digital world in a person’s reality. 

To start this, the necessary things are Google SketchUp, a webcam and then the trial version of AR-Media Sketchup plugin 
need to be downloaded, and after printing the sheet one can start to play with their models. This technology was tested in 
the office with Aravena’s ORDOS 100 model, and the result was very impressive. To work on this always start on a small 
model, after a little time the software will launch and start to work. 

https://youtu.be/wsQ-YGgVUT0 

Article Source: www.archdaily.com 
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Career Options SketchUp Users Have 

Simul Chowdhury: Editor 

SketchUp is not only a 3D designing tool but also a way leading to many career options. The best thing about the 
application is that you can learn easily how to design 3D models without having prior knowledge. The job profiles associated 
with SketchUp include architect and interior design, and a design aid in AEC industry (Architecture, Engineering and 
Construction). 

If you design in SketchUp to meet your passion, then turn your passion into a profession simply. Career options are 
numerous, and each of which relates you to the interesting world of building structures virtually. There is no certain direction 
for SketchUp Jobs, though. One can use the application as per their demands. 

SketchUp does not follow any stipulated format. This is why jobs are increasing in numbers in the fields. Innovation enriches 
its application, and designers come up with several new ways that will make you more creative. Knowing career option 
hones your skill to beat more complex designs. 

The content deals with some innovative career paths that remain unknown to the designers till date. The paths are as 
interesting and creative as their thought. Read on to learn more. 

• Architect/ Architectural Visualizer: 

Architect is another job option where SketchUp has been used primarily. You can design in the application if you are master 
over SketchUp. But to get a professional tag, you need to earn knowledge in other related software applications such as 
Indesign, Photoshop, Illustrator, AutoCAD and Revit. 

Though one can be an architect without knowing Revit or BIM applications, AutoCAD and Photoshop are the must-to-have 
option. The software will help you design more clearly and precisely when you prepare to make 3D models in SketchUp. 

As per the experts, SketchUp is a self-study. The more you spend time with the application, the better you will be in 
designing. You can also earn architect job without having the formal study of architecture. In this case, you will be restricted 
to a certain position and salary. 

• Project manager: 

A project manager uses SketchUp as a communication tool to bring out the inside of a work to the clients. SketchUp helps a 
project manager in many ways such as illustrating a worksheet condition, measuring safety issues, and more. The average 
use of SketchUp in a project manager’s job profile is 5%. 

• Concrete Product Design

Reference site: 

: 

In a concrete product design, SketchUp works as a communication tool that helps clients understand what they get. The 3D 
design of a project communicates well to the workers also as they visualize the complex works which need to be done 
applying the right method. The application in a product design includes things more than you count. 

forums.sketchup.com 
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Project Management Modeling at Trilogy Partners 

Subhra Bera: Editor 

About Trilogy Partners: It is a design-build firm situated in Breckenridge, Colorado and is specialized in arranging residential 
projects. It is the trusted, accountable, experienced expert which exploits its creative ideas and solutions for helping clients 
navigate change. The company provides clear direction, developing partnerships, high performing business processes and 
advanced growth strategies which led towards the continuous profits and growth. 

In the interview with the CEO, Michael Rath the comprehensive approach of using a virtual model as the basis for project 
management for architectural and interior design, engineering, communications and construction management by using 
SketchUp can be seen. 

Difference between Trilogy manages projects and 3D models: The Base 3D model at Trilogy got its uniqueness by the 
length of the project. At first the project get started with a note taking session and a few concept sketches then a driveway 
substitute on a printed survey will be done. The building envelope consists with some circles that were representation of the 
garage and the great room. A virtual environment is a main workspace for everyone who is connected to the project mainly 
the client. SketchUp allows for the logical evolution of concepts and ideas and project management modeling process or 
PMM which is the most useful part always preservative and progressive. In the previous software for working between one 
stages to another the user needed to sketch, print, Copy, move to CAD and at last make a print all of this and make a note 
to give the client the description. 

But now it can be only done in a model, keeping up the work only in the Base Model, like sculpting, shaping and seeing the 
things that can be fitted in it, the user doesn’t need to move. User can works moving ever forward till the time the team 
agrees that they have reached their goal to make a perfect design. Some tasks like cabinetry, trim, doors, engineering, tile, 
fireplaces, built in furnishings, closet development, plumbing, lighting and hardware works can be done outside the base 
model also in the different SketchUp files. But these all can be finalized in the base model when the model will be ready to 
receive and work on them. 

Distinction between PMM and BIM: This process is not the BIM at Trilogy but it is PMM which means that the whole 
structure will be made in SketchUp as it is easy, affordable, fast and adaptable process. The model will be filled with all the 
information which the builder required and by using SketchUp components all the things that would be manufactured can be 
represented. It will help the user to describe the source, budget, order, ship and installing them perfectly. PMM builds a 
virtual structure that looks and feels like real deal so that the client and other ones could understand where to build. PMM is 
a truthful, accessible model bespoken to the most benefited people. 

The process of keeping the models organized and easy to operate: The models of Trilogy partners are quite big and rich but 
SketchUp has the capacity to handle the greater complexity. But Trilogy designers have also been trying to develop the 
models to make them smaller than before. They have succeeded as they could now calculate the file size before dropping it 
into the model. They use 3D Warehouse and choose the component models carefully for the clients that would be fitted best 
in the model. By keeping the file small and textures below 100 Kb the model could be maintained well. 

The future level of work in SketchUp: In future they are going to include full engineering details in their virtual products and 
also working with SketchUp for heightening the BIM aspects of the program for streamline the PMM process. 

The role of extension in the Trilogy workflow: Extensions sometime uses in SketchUp for creating slowly and consciously in 
SketchUp for the most part as the app supplies. A lot of extensions sometime make the work simple but they are not ready 
for the real world. There are some extensions to help in workflow in the areas of site and terrain set up. 

The secret behind X, Y and Z: The work product of SketchUp is very expensive and sometimes 3D modeling looks like a 
luxury. But a well executed SketchUp strategy gives a fantastic model and lowers the project cost also. As the construction 
problems in the model and in the construction site can be resolved to save the money. With a good PMM model a 
supervisor can handle more projects in a lower cost and risk. The well executed SketchUp process ‘Shocker’ can actually 
lower the costs and built the future on PMM. 

For other information follow: blog.sketchup.com 
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SketchUp to VR in 10 seconds 

Subhra Bera: Editor 

This article is about the new SketchUp tool VR that is a very useful helping hand for the science fiction fans and have some 
really great features. But it works on SketchUp’s latest versions. Here is some information about the working process in VR. 
Here are also some reviews about the working features of VR; it is a smart simple and useful tool. The getting process, the 
inside view all are described here for the readers. 

VR or Virtual Reality has been a dream of science fiction fans for decades and at last it has appeared. It is mainly a multi-
sensory computer simulated visual environment which allows users to immerse themselves and interact with 3D worlds. 
Innovates from all over industries are now using this technology for telling stories and taking users on a far away adventure. 
SketchUp is one of the world’s well known popular 3D modeling programs. There is a wide variety of industries here like 
architecture, interior design, landscape architecture, and film and product design. They all are depended on the program for 
bringing their ideas to life. For viewing SketchUp models, right hardware and prospect is necessary. 

Getting Ready to Go Into VR: At first check that the file can be viewed in Prospect, as VR only works in SketchUP 2014-
2017 and also check if there is the accurate geolocation set in the file. Actually Geolocation in SketchUp is for informing the 
ability for adjusting Sun Settings in VR and perfect asses glare and shadows that casts from the natural light entering in the 
place. For viewing different scenes in the model or jumping between different rooms always make sure to have a number of 
clearly named Scenes set up as well. In the next step, configure the workstation for the virtual reality by checking that the 
headset is either an HTC Vive or Oculus Rift and then open the Prospect in the desktop. After opening the prospect, drag 
and drop a SketchUp file into the dropzone or find and upload the file by simply clicking the “Browse” option. After the file 
get selected, click the “Launch” option and for going to VR is ready. 

Inside the 3D model: After entering the VR the first thing will appear that the loaded model is in front in the Scale Model 
Mode. There one can rotate, scale and section their model for better view in the enclosed areas. By pressing the menu 
button on the controller for toggling on tooltips while in VR the user and clients both get familiarized with the various 
features. To enter in the models inside at 1:1 scale, select “Navigate” on the menu for teleporting you in. after entering one 
can explore the model and begin the mesmerizing review. 

In- Vr Tools for Immersive Review: There are many tools available for helping to produce actionable next steps and valuable 
design insights from the users time spent on reviewing the model in-VR. 

• Sun Settings: This tool use the actual geolocation that you have set up in the original Sketchup file for displaying the 
accurate lightning and shadows. By adjusting the time and date it allows user for making informed decisions about windows, 
lighting and to do shadow studies. 
• Viewpoints: They are like the camera views that are located within the model. It is a best way to walk a client or colleague 
through a project by creating a solid narrative about the space. Prospect uses Scenes from SketchUp for creating 
Viewpoints. These viewpoints can be navigated between from both scale Model Mode and in the model. 
• Layers: It can be advantaged to easily and effectively showcase the various design options, material combinations or can 
also walk through fully different layouts. The associated layers with groups can be automatically pulled into Prospect from 
SketchUp. By turning of the visibility the layers will be kept off. 

For more information and video visit blog.irisvr.com 
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SketchUp vs. Revit – Which is the Better Application? 

Simul Chowdhury: Editor 

If you have a passion for designing 3D models, you may have some preferences in choosing the 3D modeling software. 
SketchUp and Revit are both well-known in their concentrated user networks. To know which one is the best among two, 
you have to understand the underlying features first. Trimble SketchUp and Autodesk Revit stay at quite a good position 
when it comes maintaining precision in designing. But they have differences that distinguish them from each other. The 
content presents these features to you. 

SketchUp Good for the Beginners: 

Designing in SketchUp is much like drawing where you draw simple lines for your model. Generally in 3D, you are required 
to build a physical model with an ultimate measurement and size. Contrary to this, SketchUp allows users to concentrate on 
their project rather than on the designing skills. In SketchUp, outlines and features like push and pool tool help you build 
walls and floors as you desire. Keeping the features simple for you, it comes up with an easy-to-learn approach with which 
anyone can learn 3D designing without having prior knowledge. SketchUp also offers 3D warehouse – a library where 
designs are shared and uploaded to help designers across the world. 

The best thing of SketchUp is that you can also learn 3D designing for free. SketchUp Make version with features and tools 
creates a place where you can sketch your imagination without compromising quality and accuracy. 

SketchUp is also used in BIM (Building Information Modeling) to prepare the construction document. It needs a systematic 
approach from you so that the output will be as much accurate as you want. The poor result of SketchUp means that your 
model lacks in skills and design disciplines. 

Revit for Professional Designers: 

Revit works differently from SketchUp. It goes with the traditional designing style where you expect to build a physical 
structure using tools and applications. To design a wall, you need to choose the type of a wall from the preloaded section 
rather than making outlines in designing space. Editing is also done by following a few steps. You need to change the 
properties of the wall to get the desired shape and size you want. Though it is a complex process, Revit design offers a 
more accurate result than SketchUp does. Rendering your image with photo-like quality can be easily accomplished with 
Revit. 

A few drawbacks are must there when it is compared with SketchUp. You have to purchase the application to get the 
benefits. Learning the application takes time than SketchUp. Still, Revit stays at a strong place as it comes up more 
advanced tools and techniques leading you to design in the best way. 

Revit works smoother than SketchUp as the application cleans up the unnecessary works. The application seems best in 
coordination and data extraction. Users also express that Revit application runs faster than SketchUp, no matter how easy 
to learn the SketchUp tool is. 

Though both of them are 3D software applications, the working areas are different and so do the features. If designing is 
your professional need, you must keep Revit over SketchUp. 

Article Source: skwarchitects.com 
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Waybe: to build with SketchUp models 

Subhra Bera: Editor 

As we all know that SketchUp is the awesome software and the helping hand of the architects or designers and with its new 
and improving features it creates the design process more easy and lively. Here we can read about the new plugin or 
application Waybe that allows the 3D models print as a paper. The paper is simply a cut-out of any design, on which users 
can show their magic by cutting it or folding it as per their need. There is glue that recreates the magic. Download this new 
thing hurry for experiencing g the magic. 

Sketchup is a 3D software which works on both Windows and Mac machines. People are not only impressed by its ease 
and simplicity of its working process but the speed by which a 3D model can be created is also wonderful. This application 
also supports the add-ons installation which has made it more powerful. The list of the features is so lengthy that makes the 
application more popular among the users. 

3D warehouse is a vast and open library where SketchUp users can upload and download 3D models for sharing. Anyone 
can make, modify and re-upload content to and from the 3D Warehouse for free. The different software like AutoCAD, Revit 
and ArchiCAD can be downloaded from here for free of cost. Trimble is currently investigating and creating 3D developer 
partners to make more professional. SketchUp designers can visit 3D Warehouse for discovering new products or for 
creating new designs. 

The SketchUp Waybe plugin is one of the most practical and original add-ons that anybody can install on their computer. 
Waybe has brought something amazing like any digital design to the real world. It is like cut-out or a paper model o the 3D 
model building created with SketchUp. This plugin creates plans with faces and edges of the volumes. The patterns are 
prepared for printing on paper. Then the cut-out is cut, folded and glued as it can draw those important elements into a cut-
out. 

Videos of the SketchUp Waybe plugin in action: The first video shows about the SketchUp’s interface with several built 
models. In the video one can see that there is a square wheel, a polyhedron and a tank design. These designs are 
materialized in a paper model. This plugin makes up a 3D model a printable sheet by printing each element. The faces like 
cut, fold and getting object are drawn for making up the volume. 

The second one shows the detailed of the exploded view of the tank. There are also provided more details about the 
possibilities of this unique tool. For more information and details please visit the link: is-arquitectura.es 
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Magazine Details – The Creative team of Sketchup-ur-Space 

Started in September 2010, Sketchup ur Space (SuS) was the first online magazine devoted to SketchUp, that 
unique, innovative 3D design tool from Google. It holistically covers features, events, news, updates, reviews 
and many tips and tricks. 
 

 

Simul Chowdhury: simul@jobs2india.com 

Simul, the editor of SketchUp ur Space magazine is the main writer. He is responsible to 
write the cover story, blog and many other columns. Along with it, He is creating a 
liaison between the writers and the readers. 

 

 

Manoj Kumar Singh: manoj@jobs2india.com 

Manoj is enthusiastic helps to put the content of the SketchUp up Space magazine in 
the html version. Manoj is the html developer who beautifully creates each and every 
edition with care along with the PDF version. 

 

 

Abhishek Mondal: abhishek@jobs2india.com 

Abhishek is the designer-in-chief of this magazine with the help of his creativity 
Sketchup ur Space has gotten a classy as well as trendy look... 
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